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Research-Based Principles
Language concepts skills help students understand how written 
language is organized and are roughly aligned with the literary 
knowledge and language structures strands of the Reading Rope 
(Scarborough, 2001). These skills include knowledge of print concepts, 
parts of speech, punctuation, sentence structure, and text structures. 

As part of a strong foundation for learning to read, students must 
develop print awareness (Adams, 1990). Through experiences with 
print, its nature and uses are revealed to young learners. They see how 
written language corresponds to spoken language and that readers 
follow print from left to right. They learn that spaces separate words 
and begin to understand how punctuation separates ideas. They 
become familiar with a variety of genres and purposes for reading. 

Later, students learn to encode or spell according to the conventions 
of English orthography. This happens in parallel with the development 
of decoding skills. In the words of Linnea Ehri, spelling and reading are 
“mutually facilitative and reciprocal” (2000, p. 34). There is also a clear 
overlap here with fluency development—decoding and encoding are 
both part of the brain’s orthographic mapping process that enables 
the development of a large sight-word bank.

As developing readers, students build knowledge of grammar, 
including knowledge about how sentences are constructed and how 
to identify parts of speech. Research shows that an understanding of 
grammar supports reading comprehension (Silva & Cain, 2015). 
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Language Concepts  
Skills Development

Beginning Developing Advanced

	⦁ Print concepts

	⦁ Characteristics of 
a sentence

	⦁ Beginning 
punctuation, spelling, 
parts of speech, and 
text structures

	⦁ Understand and use increasingly complex parts 
of speech, punctuation, spelling conventions, 
sentence structure, and text structures in reading 
and writing

Less Complex

Parallel Focus on Comprehension

More Complex
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Waterford Early Learning 
Instruction

  → Language Concepts Skills Taught and 
Scope & Sequence

View example language concepts activities from Waterford 
Early Learning’s adaptive learning path → here.

Waterford Early Learning’s Language Concepts strand teaches 
students how written language is organized. Print concepts, parts of 
speech, punctuation, spelling conventions, sentence structure, and 
text structures are taught and practiced in this strand. 

Print concepts are explicitly taught and are modeled in Waterford Early 
Learning book experiences in the adaptive learning path. 

Text highlights match 
narration word by word, 
demonstrating print 
directionality and the 
connection between 
speech and print. 

Explicit instruction 
teaches how we 
read: turning pages 
and reading left to 
right. Students learn 
that letters combine 
to form words and 
words combine to 
form sentences.

Concepts of print are 
reinforced and reviewed 
as each new book is 
introduced. Waterford 
Early Learning books 
are available in PDF 
and interactive digital 
formats to be used for 
instruction, practice, 
and review.

https://resources.waterford.org/reference-materials/3771/3771.pdf
https://resources.waterford.org/reference-materials/3771/3771.pdf
https://www.youtube.com/playlist?list=PLcOxVO3wRlRQ12GiduaBQRsiiUU1IjzSh
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Students learn to spell (encode) according to the conventions of English 
orthography. This happens in parallel with the decoding instruction they 
experience in the Phonics strand.

Students determine the number of 
sounds in a word, then see the word 
and, finally, determine which letters 
represent each sound.

Students apply their word 
mapping skills and knowledge of 
English orthography as they spell 
multisyllabic words that include more 
complex patterns.

Grammar concepts are taught systematically. For example, students learn 
about basic characteristics of a sentence before learning about parts 
of speech.

Sentence marks Sentence structure 
and pronouns

Irregular verbs
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Engaging songs introduce students to many of the concepts in this strand. 
These songs help students understand and remember the new ideas as 
they move on to explicit instruction and practice for each concept.

Plural Nouns Synonyms
Early Morphology

Prefixes
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Resources
Resources to support language concepts skills development in the 
classroom and at home include the following:

  → Print Concepts Teacher Observation Tool

  → Print Concepts Activities

  → Sentence Builders

  → Sentence Starters

  → Closely Related Verbs

  → Distinguish Meaning Among Verbs

  → Using Words (adjectives and adverbs)

  → In Resources & Activities,

	⦁ FILTER for View>All Playlists, and SEARCH for “Waterford 
language concepts songs.”

	⦁ FILTER for Resource Type>WEL Activity and Subject & 
Strand>Literacy>Language Concepts.

	⦁ find many Waterford Early Learning books to use for print concepts 
instruction and assessment at Resource Type>Books (PreK–2).

  → Book Readability

Playlists
  → In Resources & Activities, FILTER for View>All Playlists and 

Subject & Strand>Literacy>Language Concepts.

A Waterford account is required to access program hyperlinks 
(displayed in orange). If you do not have an account, you can 
request a demo account here.

https://resources.waterford.org/teacher-resources/4950/4950.pdf
https://resources.waterford.org/teacher-resources/1870/1870.pdf
https://resources.waterford.org/practice-materials/2044/2044.pdf
https://resources.waterford.org/practice-materials/1961/1961.pdf
https://resources.waterford.org/teacher-resources/2068/2068.pdf
https://resources.waterford.org/teacher-resources/1718/1718.pdf
https://resources.waterford.org/teacher-resources/2380/2380.pdf
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities/playlists?search=Waterford%20language%20concepts%20songs
https://teacher.waterford.org/activities/playlists?search=Waterford%20language%20concepts%20songs
https://teacher.waterford.org/activities?query=resourceType%3DWEL%2520Activity%26subject%3DLiteracy%257CLanguage%2520Concepts
https://teacher.waterford.org/activities?query=resourceType%3DWEL%2520Activity%26subject%3DLiteracy%257CLanguage%2520Concepts
https://teacher.waterford.org/activities?query=resourceType%3DBooks%2520(PreK-2)
https://resources.waterford.org/reference-materials/1664/1664.pdf
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities/playlists?query=subject%3DLiteracy%257CLanguage%2520Concepts
https://www.waterford.org/reading-academy/#request-demo
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Family Resources

  → Family Fact Sheet: Language Concepts
  → Hoja de datos familiars—Conceptos de Lenguaje

  → Family Video: Language Concepts
  → Video de elemento de instrucción de conceptos de lenguaje

Decodable Books

  → Beginning Readers and Decodable Books

  → In Resources & Activities, go to

	⦁ Collections>Books: Read With Me

	⦁ Collections>Books: Foldables

	⦁ Collections>Books: Readables

https://resources.waterford.org/family-resources/4737/4737.pdf
https://resources.waterford.org/family-resources/4738/4738.pdf
https://resources.waterford.org/videos/1018/1018.mp4
https://resources.waterford.org/videos/1967/1967.mp4
https://resources.waterford.org/reference-materials/3975/3975.pdf
https://teacher.waterford.org/activities
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Read%2520with%2520Me
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Foldables
https://teacher.waterford.org/activities?query=collections%3DBooks%253A%2520Readables
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Instructional Routines
The following instructional routines can serve as frameworks for 
whole-class, small-group, and individual instruction. These routines 
leverage the elements of effective instruction that are built into the 
adaptive learning path for Waterford Early Learning.

Print Concepts
Use the → Print Concepts Observation Tool as a guide for instruction 
and modeling and to assess students’ understanding of print concepts. 

Embed print concepts instruction in the larger context of 
authentic experiences with text and a clear focus on meaning 
and comprehension.

Parts of Speech 
Use this instructional routine to build students’ understanding of the 
parts of speech.

1.	 Define the part of speech. For example, plural nouns can be defined 
as follows: “A noun is a word that names a person, place, thing, or 
animal. A plural noun is a noun that tells us there is more than one.”

2.	Share pictures that illustrate nouns and plural nouns. For example, 
pictures of one bird/two birds or one chair/a group of chairs.

3.	Watch → More Than One, encouraging students to participate by 
singing along.

4.	With assistance from students, recall and write the nouns and plural 
nouns featured in the song. Brainstorm more examples to expand 
the list.

5.	Discuss the patterns students see. Which plural nouns are formed 
by adding -s? Which ones are formed by adding -es? Help students 
discover the rule for when -es must be added.

6.	Guide students’ attention to plural nouns in connected texts during 
read-aloud experiences or as they read independently.

https://resources.waterford.org/teacher-resources/4950/4950.pdf
https://www.youtube.com/watch?v=RIqB2iKJ4AI
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7.	Provide opportunities for students to use plural nouns in 
their writing.

8.	Revisit → More Than One for engaging review and reinforcement.

Sentence Sense
Use these instructional routines to build students’ knowledge of 
sentence structure.

Elaborate Simple Sentences
1.	 Begin with a simple sentence. For example, “The dog ran.” Remind 

students that sentences have two parts. “The dog” tells us who and 
“ran” tells us what happened.

2.	With the whole group, model how the sentence can be expanded 
to be more engaging and to share more information. Prompt ideas 
through questioning. For example, “What does the dog look like? 
Where did the dog run? Why did the dog run?” Use students’ 
responses, adding their ideas one at a time. For example:

	⦁ My dog ran.

	⦁ My shaggy dog ran.

	⦁ My shaggy brown dog ran.

	⦁ My shaggy brown dog ran across the grass.

	⦁ My shaggy brown dog ran across the grass to chase his ball.

	⦁ My shaggy brown dog ran across the grass to chase his favorite 
red ball.

3.	Expanding the sentence can include changing word choice to 
convey more detail. For example:

	⦁ My shaggy brown dog dashed across the grass to chase his 
favorite red ball.

4.	When students have had sufficient experience with expanding 
sentences as a group, share a simple sentence for guided practice. 
Provide guidance and support as students work independently to 
expand the sentence.

https://www.youtube.com/watch?v=RIqB2iKJ4AI
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5.	Maintain a focus on meaning by allowing time for students to 
illustrate their sentences.

6.	Invite students to share their illustrated sentences.

Unscramble Sentences
1.	 Select a sentence from a story that is familiar to students from a 

recent read-aloud experience. For example, from The Little Red Hen, 
“Who will help me plant this wheat?”

2.	Write the sentence on a sentence strip and cut to create individual 
word cards. 

3.	Scramble the cards and show them to students. Say, “Do you 
remember what the Little Red Hen asked her friends?” Guide 
students to recall that the hen asked, “Who will help me plant this 
wheat?” Explain that all of the words needed to build the question 
are on the cards.

4.	As a group, unscramble the words. Engage students in active 
participation to put the cards in the correct order. Draw students’ 
attention to clues. The word with a capital letter must be the first 
word. The word that is followed by a question mark must be the 
last word.

5.	When the sentence is unscrambled, draw attention back to the 
meaning of the larger story. For example, read the sentence and say, 
“How did the Little Red Hen’s friends answer this question?” Invite 
students to call out the answer, “Not I!”

6.	Follow the same steps with a similar sentence. For example, “Who 
will help me harvest this wheat?”

7.	For a challenge, try one or more of the following:

	⦁ Do not include a capital letter in the first word. Do not include 
the end punctuation with the last word. Add the capital letter 
and end punctuation after the words are unscrambled.

	⦁ Follow the process with more complex sentences. Some 
complex sentences can be unscrambled in more than one way. 
Look for more than one solution!

https://resources.waterford.org/books-prek-2-/1261/1261.pdf
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8.	When students have had sufficient practice with unscrambling 
sentences with a group, engage them in guided practice with 
additional sentences. 

Corrective Feedback
Corrective feedback has been shown to be a particularly powerful 
form of feedback (Hattie & Jaeger, 1998). It has a substantial effect 
size, meaning it can significantly improve learning outcomes. Within 
Waterford Early Learning’s adaptive learning path, corrective feedback 
helps students build new understandings through productive struggle. 

As you engage students in the instructional routines outlined above, 
provide corrective feedback that

	⦁ is immediate and timely;

	⦁ is targeted and specific;

	⦁ is asset-based and encouraging;

	⦁ provides additional information, as applicable (e.g., creating an 
anchor chart with lists of interesting adjectives students can 
use in their writing);

	⦁ approaches the task in a new way, as applicable (e.g., working 
on expanding sentences in reverse by finding a complex 
sentence in a mentor text and analyzing how the author used 
words to elaborate the basic message);

	⦁ is shared through multiple modalities (e.g., visual and 
auditory); and

	⦁ does not simply provide the correct answer, but instead guides 
students to confirm or self-correct their thinking to arrive at the 
correct answer.
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